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What is CSPP?

CSPP (Community Satellite Processing Package) is a 
collection of software systems for processing data 
from meteorological satellites.  

The primary goal of CSPP is to support users who 

• Receive satellite data via direct broadcast; 

• Create Level 1B and higher level products and 
images in real time. 

Funding is supplied by JPSS and NOAA.
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CSPP Software Philosophy

The CSPP software 

Creates useful products for the DB community, 

Includes up-to-date algorithms, 

Is pre-compiled for 64-bit Intel Linux (CentOS), 

Is easy to install and operate, 

Includes test data for verification, 

Runs efficiently on modest hardware, 

Has prompt user support.
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CSPP by the numbers

Satellites supported: 7 

Software packages: 10 

Sensors supported: 25 

Releases and updates: 29 

Registered users: 913 

Individual downloads: > 5000
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Satellite Multispectral Imager Infrared Sounder Microwave Sounder

Suomi NPP VIIRS 
SDRs (Level 1B), Images, 
Visualization, Clouds, 
Aerosols, Land, Ocean

CrIS 
SDRs (Level 1B) 
Atmospheric Profiles, 
Clouds, Visualization

ATMS 
SDRs (Level 1B), 
Atmospheric Profiles, 
Precipitation, Visualization

Metop-A/B AVHRR 
Clouds, Aerosols, Land 
Surface, SST, Visualization

IASI, HIRS 
Atmospheric Profiles, 
Clouds, Visualization

AMSU, MHS 
Atmospheric Profiles, 
Precipitation

NOAA-18/19 AVHRR 
Clouds, Aerosols, Land 
Surface, SST, Visualization

HIRS 
Atmospheric Profiles

AMSU, MHS 
Atmospheric Profiles, 
Precipitation

Terra MODIS 
Images, Visualization

N/A N/A

Aqua MODIS 
Images, Visualization

AIRS 
Atmospheric Profiles, 
Clouds, Visualization

AMSU 
Atmospheric Profiles, 
Precipitation, Visualization

CSPP Satellite/Sensor/Product Matrix
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CSPP Software (Apr 2015)
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CSPP Software Product Description

1. SDR VIIRS, CrIS, and ATMS geolocated and calibrated earth observations.

2. VIIRS EDR VIIRS imager cloud mask, active fires, surface reflectance, vegetation indices, sea surface 
temperature, land surface temperature, and aerosol optical depth.

3. HSRTV Hyperspectral infrared sounder retrievals of temperature and moisture profiles, cloud 
properties, total ozone, and surface properties.

4. Polar2grid Reprojected imagery (single and multi-band) in GeoTIFF and AWIPS formats.

5. Hydra Interactive visualization and interrogation of multispectral imagery and 
hyper spectral soundings.

6. MIRS Microwave sounder retrievals of temperature and moisture profiles; surface properties; 
snow and ice cover; rain rate; and cloud/rain water paths. 

7. CLAVR-x Multispectral imager retrievals of cloud properties; aerosol optical depth; surface 
properties; ocean properties. 

8. NUCAPS Combined hyperspectral infrared sounder and microwave sounder retrievals of 
temperature and moisture profiles, cloud cleared radiances, and trace gases. 

9. IAPP Combined infrared sounder and microwave sounder retrievals of temperature and 
moisture profiles, water vapor, total ozone, and cloud properties.

10. ACSPO Multispectral imager retrievals of sea surface temperature.



CSPP Software Suomi NPP Metop-A/B NOAA-18/19 Terra Aqua

1. SDR VIIRS, CrIS, ATMS Provided by 
AAPP

Provided by 
AAPP

Provided by 
SeaDAS

Provided by 
SeaDAS

2. VIIRS EDR VIIRS N/A N/A N/A N/A

3. HSRTV CrIS IASI N/A N/A AIRS

4. Polar2Grid VIIRS, CrIS, IASI Future version Future version MODIS MODIS, AIRS

5. Hydra VIIRS, CrIS, ATMS AVHRR, IASI AVHRR MODIS MODIS, AIRS

6. MIRS ATMS AMSU, MHS AMSU, MHS N/A N/A

7. CLAVR-x VIIRS AVHRR AVHRR MODIS MODIS

8. NUCAPS CrIS, ATMS Future version N/A N/A Future version

9. IAPP N/A HIRS, AMSU, 
MHS

HIRS, AMSU, 
MHS

N/A N/A

10. ACSPO VIIRS AVHRR AVHRR MODIS MODIS

CSPP Software/Satellite/Sensor Matrix
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CSPP Registered User Locations
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February, 2015



1. CSPP SDR

CSPP SDR (Sensor Data Record) creates calibrated and 

geolocated earth observation products (Level 1B).

9

Heritage Developed by Raytheon and released as part of Algorithm 
Development Library (ADL). Source code is available in ADL.

Satellites/Sensors SNPP (VIIRS, CrIS, ATMS). 

Products VIIRS: M-band, I-band, and Day/Night Band SDR calibrated 
sensor data and geolocation files in HDF5 format. 
CrIS: Calibrated spectra and geolocation in HDF5 format. 
ATMS: Calibrated antenna temperatures and geolocation in 
HDF5 format.

Features • Multi-core support for faster processing. 
• Optional product aggregation and compression. 
• Automated download and installation of calibration LUTs. 
• Quicklook images



SDR Examples
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SNPP 2015/04/08 19:10 UTC
CrIS MW

ATMS Ch 2

VIIRS M7

VIIRS M15

SNPP 2015/04/08 19:10 UTC



2. CSPP EDR

CSPP EDR (Environmental Data Record) creates atmosphere, 

land, and ocean products.
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Heritage Developed by Raytheon and released as part of Algorithm 
Development Library (ADL). Source code is available in ADL.

Satellites/Sensors Suomi NPP VIIRS. 

Products Cloud Mask, Active Fires, Aerosol Optical Thickness, Suspended 
Matter, Sea Surface Temperature, Surface Reflectance, Normalized 
Difference Vegetation Index, Enhanced Vegetation Index, Surface 
Type, Land Surface Temperature, and Imagery in HDF5 format.

Features • Multi-core support for faster processing. 
• Optional product aggregation and compression. 
• Automated download and preparation of ancillary data. 
• Quicklook images.



EDR Examples
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Cloud Mask

Aerosol Optical Thickness

Sea Surface Temperature

Land Surface Temperature

SNPP 2015/04/05 18:26 UTC



3. HSRTV

HSRTV (High Spectral Resolution Retrieval) creates temperature, 

moisture, and trace gas profiles, and cloud products.
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Heritage Developed at CIMSS/SSEC by Bill Smith, Elisabeth Weisz, and 
Nadia Smith.

Satellites/Sensors Suomi NPP CrIS; Metop-A/B IASI; Aqua AIRS. 

Products Temperature, moisture, and ozone at 101 pressure levels; surface 
skin temperature and emissivity; total column water vapor and 
ozone; CO2 amount; cloud mask; cloud top pressure and 
temperature; and cloud optical thickness in HDF5 format

Features • Common multi-sensor algorithm. 
• Single field of view retrievals. 
• Fast regression algorithm.



HSRTV Examples
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SNPP 2015/04/02 19:25 UTC 
Metop-B 2015/04/02 16:35 UTC

CrIS 
Mixing ratio 
500 hPa

IASI 
Mixing ratio 
500 hPa

CrIS 
Temperature 
500 hPa

IASI 
Temperature 
500 hPa



4. Polar2grid

Polar2grid creates reprojected imagery for single bands 

(grayscale) and band composites (RGB).
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Heritage Developed at CIMSS/SSEC by Dave Hoese.

Satellites/Sensors Suomi NPP VIIRS; Terra/Aqua MODIS. 

Products Single band and multi-band images in GeoTIFF and netCDF 
formats (for AWIPS).

Features • Atmospherically corrected true color images. 
• Automatic adaptive enhancement for VIIRS Day/Night band. 
• User defined projection grids are supported. 
• Multiple input granules are composited on one output image.



Polar2grid Examples
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SNPP 2015/04/06 06:44 UTC 
SNPP 2015/04/06 20:07 UTC

VIIRS True Color

VIIRS M15 in AWIPS2

VIIRS DNB



5. Hydra

Hydra is an interactive GUI application for 

exploring multispectral satellite data.
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Heritage Developed at CIMSS/SSEC by Tom Rink.

Satellites/Sensors Suomi NPP VIIRS, CrIS, ATMS; Metop-A/B IASI; Terra/Aqua MODIS; 
Aqua AIRS. 

Products Images in JPEG and KML format.

Features • Supports Windows, OS X, and Linux platforms. 
• Simple to install and use for training/classroom environments. 
• Multi-sensor comparisons (e.g., MODIS/VIIRS) are supported. 
• User-defined band combinations, scatter plots, and transects.



Hydra Examples
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 6 

 
Figure 2:  Band 1 (.65 µm) (left panel) and Band 6 (1.6 µm) (center panel) reflectance images along 
with the scatter diagram created by plotting Band 6 versus Band 1 (right panel). 
 
4.  Now close the scatter diagram window and open the MODIS cloud product file from the same date 
and time (File-> File(s)-> MOD06_L2.A2014170.1605.051.2014171015558.hdf).  Choose 
Cloud_Phase_Infrared, and Overlay this field onto the Band 6 (1.6 µm) image.  The color coding for 
the Cloud Phase product is: 
 

Pink is Ice Cloud  
Blue is Water Cloud,   

 is possible Mixed Phase Cloud and  
Green is Undetermined. 

 
Toggle between the Cloud Phase and Band 6 image to see how the phase matches with the darker and 
brighter reflectances.  Do you think you could quickly determine cloud phase by looking solely at 
Band 6? What could this tell you about the maturity of a thunderstorm?  What are the limitations of 
using only Band 6 reflectances to determine cloud phase?  
 
5.  Now go back to the Band 31 (11.0 µm) data, change the enhancement to InvRainbow and note the 
location of the coldest clouds.  Display the Band 34 (13.7 µm) brightness temperatures into a new 
window.  Draw a transect through the coldest cloud tops in Band 31 (11.0 µm) as show in Figure 3 by 
selecting Tools->Transect and positioning the line by grabbing and moving the end points. Add the 
Band 34 (13.7 µm) brightness temperatures to the transect by selecting Tools->Transect in that image 
window. How do the brightness temperatures compare? Where are the temperatures similar and where 
are they different?  What is causing the differences?  Now display Band 35 (13.9 µm) and Band 36 
(14.2 µm) in new windows, and add transects for both.  What is causing the difference in the 
temperatures away from the cold clouds?  How could these bands be used to differentiate different 
types of clouds?  Close the transect window when you are finished. 
 

VIIRS Data Selector VIIRS M15 Image Window VIIRS I1 Image Window

MODIS Band 6 vs. Band 1 Scatter Plot

SNPP 2015/01/30 18:40 UTC 
Terra 2014/06/19 06:05 UTC



6. MIRS

MIRS (Microwave Integrated Retrieval System) creates 
atmospheric profile, precipitation, and surface products from 
microwave sounder data.
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Heritage Developed at NOAA/NESDIS by Sid Boukabara, Chris Grassotti, et 
al.

Satellites/Sensors Suomi NPP ATMS; Metop-A/B AMSU, MHS; NOAA-18/19 AMSU, 
MHS.

Products Temperature and moisture profiles, total precipitable water, 
surface skin temperature and emissivity, rain rate, cloud liquid 
water, rain water path, ice water path, liquid water path, sea ice 
concentration, snow water equivalent, and snow cover.

Features • Multi-sensor common algorithm. 
• Physics-based retrieval. 
• Retrieves land and ocean products in all sky conditions. 
• Extensively validated and documented.



MIRS Examples
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SNPP ATMS Surface Skin Temperature with Rain Rate 
contours and isosurface of Rain Mass Profile

Metop-B 2015/03/30 02:01 UTC 
SNPP 2015/03/18 11:03 UTC

Metop-B AMSU/MHS 840 hPa 
temperature and water vapor



7. CLAVR-x

CLAVR-x (Clouds from AVHRR Extended) creates quantitative 
cloud, aerosol, and surface products from imager data.
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Heritage Developed at NOAA/NESDIS/STAR and CIMSS/SSEC by Andy 
Heidinger, Andi Walther, Denis Botambekov, et al.

Satellites/Sensors Suomi NPP VIIRS; Terra/Aqua MODIS; Metop-A/B AVHRR; 
NOAA-18/19 AVHRR.

Products Cloud mask, type, fraction, and phase; cloud top height, pressure, 
temperature, and emissivity; cloud optical depth and effective 
radius; aerosol optical thickness; normalized difference vegetation 
index; sea surface temperature; all in HDF4 format.

Features • Multi-sensor common algorithm. 
• Product files include cloud and surface products, calibrated 

observations, and many ancillary data fields (user controlled). 
• CLAVR-x is the official NOAA cloud product for JPSS.



CLAVR-x Examples
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SNPP 2013/03/10 23:00 UTC

VIIRS False Color SST Ancillary Data Cloud Masked SST

Cloud Top Temperature Cloud Water Path Rain Rate



8. NUCAPS

NUCAPS (NOAA Unique CrIS/ATMS Processing System) retrieves 
atmospheric temperature, moisture, and trace gases from 
combined infrared and microwave observations.
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Heritage Developed at NOAA/NESDIS/STAR by Chris Barnet, Antonia 
Gambacorta, Walter Wolf, Mark Liu et al.

Satellites/Sensors Suomi NPP CrIS/ATMS

Products Temperature, water vapor, and ozone profiles; trace gas profiles 
including ozone, carbon monoxide, methane, carbon dioxide, 
nitrous oxide, sulphur dioxide; infrared and microwave surface 
emissivity; cloud cleared radiances.

Features • Multi-sensor common physical retrieval algorithm. 
• Future versions will support Metop-A/B IASI/AMSU/MHS and 

Aqua AIRS/AMSU. 
• NUCAPS is the official NOAA sounding product for JPSS.



NUCAPS Examples
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SNPP 2015/04/03 19:07 UTC

Temperature Water Vapor Mixing Ratio



9. IAPP

IAPP (International ATOVS Processing Package) retrieves 
atmospheric temperature and moisture, total ozone, and cloud 
top properties from ATOVS sounder data.
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Heritage Developed at CIMSS/SSEC by Hal Woolf, Jun Li, Chia Moeller, Tom 
Achtor et al.

Satellites/Sensors NOAA-18/19 HIRS/AMSU/MHS; Metop-A/B HIRS/AMSU/MHS.

Products Temperature and water vapor profiles; total column water vapor 
and ozone; cloud fraction; cloud top pressure and temperature; 
surface skin temperature and microwave emissivity. 

Features • Fast regression first guess; iterative nonlinear physical retrieval. 
• Also supports NOAA-15/16 (non operational).



IAPP Examples
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Metop-B 2015/04/02 16:35 UTC 
NOAA-18 2015/04/02 23:08 UTC

Metop-B Temperature at 850 hPa

Metop-B Water Vapor at 850 hPa

NOAA-18 Temperature at 850 hPa

NOAA-18 Water Vapor at 850 hPa



10. ACSPO

ACSPO (Advanced Clear-Sky Processor for Oceans) retrieves sea 
surface temperature from multispectral imager observations.
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Heritage Developed at NOAA/NESDIS/STAR by Alex Ignatov, John Sapper, 
John Stroup, and Yury Kihai.

Satellites/Sensors Suomi NPP VIIRS; NOAA-18/19 AVHRR; Metop-A/B AVHRR; Terra/
Aqua MODIS.

Products Sea surface temperature, aerosol optical thickness; and clear-sky 
radiances.

Features • Multi-sensor common algorithm. 
• ACSPO is the official JPSS algorithm for SST.



ACSPO Examples
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2015/04/02

VIIRS SST 17:44 UTC MODIS SST 18:35 UTCAVHRR SST 18:31 UTC

VIIRS SST 2015/03/18 07:40 UTC



Future additions: CrIS FSR

CrIS switched to full spectral resolution mode on 2014/12/04. 
Current CSPP SDR software reduces the resolution. 

Prototype software for calibration at full spectral resolution 
has been developed at NOAA/NESDIS/STAR by CrIS SDR team: 

• Running operationally at CIMSS/SSEC on DB data since 
January 2015. 

• Software package is available on request for beta testing. 

• CSPP version of CrIS full spectral SDR is expected by end of 
2015. 

• Current version will still be available (reduced resolution). 
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Future additions: MIPS

The Multispectral Image Processing System 

(MIPS) is designed to create high-quality true 

color and false color composited images in 

GeoTIFF, JPEG, and KML format. 

• Supports SNPP VIIRS, Terra/Aqua MODIS, and FY-3 

MERSI. 

• Allows composites to be created for a DB region, 

polar regions, or the entire globe.
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MIPS Examples
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SNPP VIIRS 2015/04/09



CSPP Summary

• CSPP continues to support the polar orbiting 

satellite DB community with a wide range of 

software and products supporting Suomi NPP, 

Metop, NOAA, and EOS satellites. 

• CSPP GEO now supports geostationary satellites. 

• We look forward to JPSS-1 in early 2017. 

http://cimss.ssec.wisc.edu/cspp/
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